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Operations via Cloud Auto-upload settings enable this product to automatically upload data to T&D WebStorage Service. 
Please read the T&D WebStorage Service License Agreement carefully before making settings.
Making Auto-upload Settings indicates your acceptance of this Agreement.

T&D WebStorage Service
T&D WebStorage Service is a free cloud-based storage service provided by T&D 
Corporation, which enables you to access the uploaded recorded data from a web 
browser and check the current readings, remaining battery life of the device, and 
alert status. You can also receive warning notifications by email. In order to use the 
T&D WebStorage Service, user registration (free) and device registration are required.

Important Notes
• Before registering as a user, please read [Service Details / License Agreement] for 

information on service contents and specifications, including the data storage 
period in the T&D WebStorage Service.

• The registration code of the device can be found on the supplied Registration 
Code Label. If you lose the code label, install the software TR7 for Windows and 
connect your logger via USB to the computer. The registration code and device 
information will be displayed at the lower-left area of the screen.

• When the storage period in T&D WebStorage Service is exceeded, old data will be 
deleted.

User and Device Registration Procedures

	. Access T&D WebStorage Service from the web browser.

 https://www.webstorage-service.com
	. Click [Create Account] to go to the registration page, and follow the directions to 

complete the registration.
	. Login by entering the registered User ID and Password.
	. Click [Devices] in the left menu to open the Device Settings window.
	. Clicking the [+Device] button will take you to the Add a Device page.
	. Enter the serial number and registration code for the device, then click [Add].
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In this document, TR-71nw, TR-72nw, TR-72nw-S and TR-75nw are collectively referred to as the “TR-7nw 
Series” or simply as the “device” or “logger”.

 Making Auto-Upload Settings
By making settings for auto-upload, it is possible to automatically 
upload recorded data to the online “T&D WebStorage Service”.

	. Connect a LAN cable to the Ethernet port.

If you wish to use a static IP address instead of DHCP, change the network settings 
on our software "TR7 for Windows" by connecting the device to a PC via USB. For 
details about operations please see the "Help" menu in the software.

	. Click the <INTERVAL> button 
twice to display the current 
upload interval.

	. Press the <INTERVAL> button until the display flashes.

	. With each pressing of the <INTERVAL> button the upload interval 
time will change. When the desired interval appears, stop pressing 
the button.

If you wish NOT to use the auto-upload feature, select “OFF”.  
Within a few seconds, the display will return to measurement mode 
to indicate the upload interval is set.

Below are some examples of upload intervals and the corresponding estimated 
battery life.
In general, the shorter the upload interval, the shorter the battery life.

Upload Interval 1 min. 10 min. 1 hr. 12 hrs.

Battery Life About 10 days About 2 months About 1 year About 1.5 years

 • All estimates are based on operations carried out with a new battery and are in no 
way a guarantee of actual battery life.

 • The auto-upload interval can also be changed during a recording session.

 Installing the Device
Install the device to the actual place it will be used.

Check Internet Connection Status

Internet Router / HUB

Checking Transmission and Connection Status
By pressing the <REC/STOP> button, recorded data will be sent to "T&D WebStorage 
Service". If the transmission is successful,  will still be ON even after communica-
tion is complete and  turns OFF.

 is ON :  Internet connection is successfully established.
 is blinking : Internet connection failed. Please check the network settings.

 is blinking upward : Data is being transmitted.

 Checking Recorded Data
	. Access "T&D WebStorage Service" from the web browser on your 

PC or mobile device.

 https://www.webstorage-service.com

	. Click [Create Account] to go to the registration page, and follow the 
directions to complete the registration. If you already have your 
User ID, go to the next step.

	. Login by entering the registered User ID and Password.

	. In the [Device Settings] window click [+Device].

	. In the Add a Device page, enter necessary information and click 
[Add]. 
The registration code can be found on the supplied Registration Code Label.

	. After data is sent to "T&D WebStorage Service" either by auto-upload 
or by pressing the <REC/STOP> button on the logger, the added 
device and its measurements will appear in the [Data View] window.

If measurements are not displayed:
 • Check the device screen to make sure  is ON. Recorded data will not be uploaded 

when recording is not in progress.
 • Try sending data to "T&D WebStorage Service" again by pressing the <REC/STOP> 

button on the device.
 • See "Checking Connection Status" in step 2, and check if the device has a LAN connec-

tion.

If the display of measurements is not refreshed:
We recommend making the recording interval shorter than the auto-upload interval. If 
the recording interval is set to longer than the upload interval, the same measurement 
is displayed until the next recording occurs and the new data is uploaded.

If you cannot find the registration code:
See [T&D WebStorage Service] - [important Notes] on the left side of this paper.

Viewing Data from other than a Web Browser
Recorded data sent to "T&D WebStorage Service" can be accessed, 
viewed and downloaded directly from "T&D Thermo" and "T&D Graph" 
as well as from a web browser.
Here explains how to view data from "T&D Graph". For information about "T&D Thermo", 
see [Operations via Mobile APP] on the back of this manual. 

	. Download and install the software T&D Graph from T&D Website.
https://tandd.com/software/td-graph.html

	. From the [File] Menu, select [Web Storage Service].

	. Enter the User ID and Password registered with T&D WebStorage Service, 
and click [Login]. 
Upon successful login, the recorded data of the devices registered 
with your account will be displayed.

	. Double click on the recorded data you wish to view in a graph. 
The data will be downloaded and displayed in a graph.

 Changing the Settings
By using the “T&D WebStorage Service”, it is possible to change 
the following settings.
Device Information: 
Device Name, Group Name, Recording Interval, Recording Mode, Auto-upload 
Interval, Channel Name, Time Settings, Temperature Unit

Warning Settings: 
Lower Limit, Upper Limit, Sensor Warning, Judgement Time, Battery Warning

The changes in settings will be applied when the device communicates 
with the "T&D WebStorage Service". To apply the changes immediately, 
press the <REC/STOP> button on the device after settings are completed.

Recording Interval Setting
Install the batteries and sensor(s) in the logger, and make sure 
the LCD is displaying measurements. The factory default setting 
for the recording interval is 10 minutes for TR-75nw and 1 minute 
for TR-71nw/TR-72nw. Follow the procedure below to change this 
setting.

• Skip this setting if you don’t need to change the recording interval.
• Upon the start of recording, all previously recorded data in the logger will be 

deleted.
• Note: When  is ON (recording in progress), the logger cannot be turned 

off , nor can the recording interval be changed.

	. When  is ON, press-and-hold the <REC/STOP> button until  
turns OFF (recording stops).

	. Press the <INTERVAL> button.

	. While  is displayed, press-and-hold the <INTERVAL> button 
until the interval time flashes.

	. Press <INTERVAL> again to select the interval time. Each press 
changes the interval as follows: 
Recording Intervals ( ) 1, 2, 5, 10, 15, 20, 30 SEC / 1, 2, 5, 10, 15, 20, 30, 60 MIN

	. When you stop pressing the button, the display will return to the 
normal measurement mode, confi rming that it is set.

	. Start recording by pressing and holding the <REC/STOP> button until 
the  mark appears in the display.

Below are some examples of recording intervals and maximum recording times.
1 sec. 30 sec. 5 min. 15 min. 60 min.

About 2 hours About 2 days About 27 days About 83 days About 333 days
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In order to stop a recording session, press and hold the <REC/STOP> button until the 
 mark disappears from the display.

Details about the LCD Display
Other than the measurement display, the following is displayed on 
the LCD monitor.

Internet Connection Status
ON : Connected to the Internet.
BLINKING : Unable to connect to the Internet.
OFF : Auto-upload is set to “OFF”.

 Displayed Measurement Channel

LAN or USB Communication in Progress

Recording Status
ON: Recording in progress
BLINKING: Waiting for programmed start
OFF : Recording stopped

Recording Mode
ENDLESS :   Upon reaching the logging capacity of 8,000 readings, the oldest data is 

overwritten and recording continues.
ONETIME :   Upon reaching the logging capacity of 8,000 readings, [FULL] appears 

on the LCD display and recording automatically stops.
 * Cannot be set or changed using buttons on the logger. The factory default 
setting is “ENDLESS” 

Amount of Recorded Data in Device

Low Battery Level
Please change the batteries as soon as you see this mark. If not, the device enters 
sleep mode ([SLP] appears on LCD) and stops all operations. If the batteries are 
further left unchanged, all previously recorded data will be lost.

Indicates Auto-upload Interval when using <INTERVAL> button

Indicates Recording Interval when using <INTERVAL> button

Messages on LCD Screen

Sensor Error: No sensor connected, improper connection, damaged, etc.

Full Data: Upon reaching capacity of 8,000 readings in "ONETIME" mode, 
this message appears and recording automatically stops.

Sleep Mode: If you take no action after a battery warning mark appears 
and auto-upload stops, the logger will enter sleep mode and stop all 
operations to protect data.
All operations are stopped to protect data in sleep mode.
• If the logger remains in sleep mode over one week without a change of 

batteries, all recorded data will be lost.

Thermocouple Sensor Type (TR-7	nw only)
By pressing and holding the <DISPLAY> button, you can see which 
sensor type is currently set for each channel as below.

In the example shown left, 
Channel 1 is set to Type K,
Channel 2 is set to Type J.

Type T
Other sensors ...

Type RType E Type S

The factory default setting is “K” for both  . Depending on the thermocouple type you’re 
going to use, make settings or changes using “T&D WebStorage Service” or the software “TR7 for 
Windows”.

https://tandd.com
https://www.webstorage-service.com
https://www.webstorage-service.com
https://tandd.com/software/td-graph.html


Operations via Moble APP Operations via USB
 ”T&D Thermo” App Settings

	. Install "T&D Thermo" to your smartphone or tablet.
“T&D Thermo” is available on the Apple Store for iOS devices and the Google Play Store for 
Android devices.

	. Search for "T&D Thermo" on the Apple Store for iOS devices and 
the Google Play Store for Android devices.

	. Open "T&D Thermo".

	. Tap the menu icon in the upper left corner of the screen, and tap 
[App Settings].

	. Tap [Account Management] for T&D WebStorage Service.

	. Enter the User ID and Password for your account, and tap [Apply].
If you added more than one account, select the account you want to access.

7. Tap  to return to the top screen.

 Graph Display and Device Settings

	. From the list on the top screen, tap the device registered with T&D 
WebStorage Service to open the Device Info screen.

The [WSS] icon will appear 
for devices registered to the 
cloud.

	. Tap [WebStorage] at the bottom of the screen. 
This will access the logger via T&D WebStorage Service and open 
the Graph/Device Settings screen.

Device Info screen Graph/Device Settings screen

Access to 
Cloud

Graph Operations
Zooming in and out Pinch in/out to change the scale.
Full screen display Hold the smartphone horizontally.
Checking time and temperature at 
the specified point Tap and hold on the graph (in full-screen mode).

Device Settings
You can view or make changes to the settings such as Rec Settings, Name Settings, 
Warning Settings and Auto-upload Interval. 
Changed settings will be applied the next time the device connects to the T&D 
WebStorage Service.

The   icon indicates that 
there are pending settings.

 Saving and Sharing Recorded Data

Device Info screen File ListGraph/Device Settings screen

	. To save the recorded data to your device, tap  in the upper right 
corner of the Graph/Device Settings screen.

	. Tap [Files] at the bottom of the Device Info screen to open the file 
list.

	. Select a file and tap the desired icon at the bottom of the screen.

For details about T&D Thermo, refer to the online help.
https://tandd.com/support/webhelp/tdthermo/

T&D Data Server
“T&D Data Server” is a Windows software that receives and stores data 
recorded by TR-7nw Series data loggers to the server’s database. It is 
possible to monitor current readings and warnings via a web browser. 
When you wish to have recorded data automatically uploaded to your 
server rather than T&D WebStorage Service, please use "T&D Data Server".

https://tandd.com/software/td-data-server.html

	. Install T&D Data Server on the computer to be used as a server, 
and open the [T&D Data Server Manager] window.

	. Enter the Server Address and Port Number.

• The IP address(es) for the server PC will automatically appear. If there 
are multiple networks, select the IP address for the network waiting for a 
connection.

• The default Port Number is 80.
• The settings cannot be changed while the server function is running. Please 

click the [OFF] button to stop the server function.

	. Place a check next to "Do not allow the computer to enter sleep 
mode."

	. Click the [ON] button.
• If Windows goes in "Standby" or "Sleep" mode, reception of recorded data and 

monitoring can not be carried out.
• The IP address and port number set here will be used in the Windows software  

"TR7 for Windows" as the data destination in the Auto-upload Settings. For 
details about operations of "TR7 for Windows" , please refer to the software's 
Help.

Monitoring
To open the monitoring window, open your web browser, and in the address bar 
enter the server address set in Data Server Settings.

Graph View
In the monitoring window, click the desired device name to view the data in graph 
form.

For details about the operations of T&D Data Server, refer to
https://cdn.tandd.co.jp/glb/html_help/tddataserver-help-eng/

It is possible to make device settings and download recorded 
data by using the software "TR7 for Windows". Data 
downloaded can then be viewed in a graph for analysis by 
using our software "T&D Graph".

Primary features of "TR7 for Windows" include:
 • Start/Stop Recording
 • Auto-upload Setting
 • Network Settings (static IP address, etc.)
 • Name Settings (device/group/channel)
 • Downloading and Saving Recorded Data
 • Warning Settings
 • Time Settings
 • Sensor Type Setting (TR-75nw only)
 • Report Creation and Output
 • Settings and Log Output
 • Reset to Factory Default Settings 

 Setting Up
	. Download and install the software "TR7 for Windows" and “T&D 

Graph“ from T&D Website.

 https://tandd.com/software/tr7forwin.html 
https://tandd.com/software/td-graph.html

	. Connect the logger via USB to your computer.

USB Communication Cable
(US-15C)

• "TR7 for Windows" will open automatically. (If not, please open it manually 
from the Windows Start Menu or Start Screen.)

• For details about operations please see the "Help" menu in the software.

	. After the setup is complete, place the device to the desired 
measurement location.

 Downloading Recorded Data
	. Connect the logger via USB to your computer.

	. Open “TR7 for Windows”, click the [Download Recorded Data] tab 
and proceed with the download.

[Detailed Settings] allow you to:
• View and change the “Graph Display” and “File Name” settings
• Select whether to create a report (PDF/CSV) with daily maximum and minimum 

values and total time out of threshold, etc.

For details about the operations of TR7 for Windows, refer to
https://cdn.tandd.co.jp/glb/html_help/tr7win-help-eng/

 Viewing Recorded Data in Graph
Open “T&D Graph” and then access the data you wish to view. 
Upon completion of the download, "T&D Graph" will open and 
display the graph.

For details about the operations of T&D Graph, refer to
https://cdn.tandd.co.jp/glb/html_help/tdgraph-help-eng/

Device Button Operations

<POWER> Button

Power ON/OFF Press-and-hold*1 the <PWR> button.

Start*	 / Stop Recording Press-and-hold the <REC/STOP> button.

Check Recording Interval / 
Upload Interval 

Press the <INTERVAL> button.
With each pressing of the button, the display will 
switch between the recording interval ( ) and 
the upload interval ( ).

Recording Interval Setting
Press the <INTERVAL> button. While  is 
displayed, press-and-hold*3 the <INTERVAL> 
button until the interval time flashes. Press 
<INTERVAL> again to select the interval time.

Upload Interval Setting
Press the <INTERVAL> button twice. While  
is displayed, press-and-hold the <INTERVAL> 
button until the interval time flashes. Press 
<INTERVAL> again to select the interval time.

Transmit Data and Settings 
to T&D WebStorage Service Press the <REC/STOP> button.

Cancel Communication Press the <PWR> button.

Channel on Display (Fixed 
or Alternating Display)

Press the <DISPLAY> button to switch the display:
Ch1 (fixed)  Ch2 (fixed)  Ch1&2 (alternate)

TR-7	nw Sensor Type Press-and-hold the <DISPLAY> button.

*1. “Press-and-hold” means to hold the button down for about two seconds. Dur-
ing recording, the power cannot be turned off.

*2. Upon the start of recording, all previously recorded data in the unit will be 
deleted.

*3. Recording Interval setting cannot be changed while a recording session is in 
progress.

Before performing button operations, please read the attached document 
[Please Read First] and install the batteries and sensor(s) in the logger, and 
make sure the LCD is displaying measurements.

https://tandd.com/software/td-data-server.html
https://cdn.tandd.co.jp/glb/html_help/tddataserver-help-eng/
https://tandd.com/software/tr7forwin.html
https://tandd.com/software/td-graph.html
https://cdn.tandd.co.jp/glb/html_help/tr7win-help-eng/
https://cdn.tandd.co.jp/glb/html_help/tdgraph-help-eng/

